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Section I: Introduction

Macromedia Dreamweaver is a very powerful and sophisticated yet intuitively designed
web authoring program. Like FrontPage, it is capable of designing and maintaining entire
web sites. Unlike FrontPage,

• It allows for easy development and maintenance of single web pages
• It adheres more closely to true W3-approved HTML coding-- no Microsoft

proprietary coding-
• You can take full advantage of anything you create with Dreamweaver without

needing to host the pages on a Microsoft web server

Dreamweaver is an excellent "next step" program for people who have some experience
using entry-level authoring programs such as Netscape Composer. Most users find it easy
to make the jump into using the basic functions and can grow into many of its higher-
level features as they need them.

Dreamweaver functions well as a standalone program but also works closely with
companion programs Fireworks and Flash. These programs are available individually or
as a packaged suite, often with a generous educational discount.

While the materials here focus on the basics of Dreamweaver 3.0, the skills & familiarity
developed should transfer easily to Macromedia Ultradev. Ultradev includes many
higher-level features for accessibility, databases, file conversion, etc.

Oh, by the way, that song going through your head right about now is "Dream Weaver,"
1975 by Gary Wright. A semi-one hit wonder, he didn't do much else you'd remember but
he did play keyboards on George Harrison's  'All Things Must Pass.'

Goals and Objectives
The target learner for this material has the following entry characteristics:
• Has some experience with simple web page authoring in a WYSIWYG environment
• Can function comfortably in a networked Windows environment
• Understands web page saving/storing at Oakton
• Has a basic knowledge of HTML markup concepts

This document is intended to introduce learners to
• The basic layout of Dreamweaver
• The essential functions of Dreamweaver needed for creating simple web pages

Upon completion, the learner will be able to
• create a simple web page using such elements as

• Text, tables, images and links
• locate and launch key features of Dreamweaver, such as

• Drop menus, popup menus, properties palettes and object palettes
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Starting Dreamweaver 3.0 on Oakton's network
1. Click the Start menu (lower left corner of computer desktop)
2. Click on NAL
3. Click on Internet Software
4. Click on Web Design
5. Click on Macromedia Dreamweaver 3
Note: You may also launch Netscape at this time.

Section II: Dreamweaver Layout
The Dreamweaver 3 Document Window
Dreamweaver initially launches the main Document Window in basic WYSIWYG view.
The Document Window is your canvas where you lay out and/or modify the contents of
your web page.
In this view you can access features and commands from the menu bar (top) and the
launcher bar (bottom right). Depending on your system default settings, other items like
"Floating Palettes" will either launch automatically or require you to launch them
manually (see next section).

The image below shows the 'plain vanilla' Document Window with no floating palettes.

Menus and Floating Palettes Overview

Dreamweaver allows access and modification of most all features and functions via either
its menus (File, Edit, etc.) or "Floating Palettes," small windows independent of the main
Document Window that can be opened and closed or dragged around the desktop to
wherever is convenient.

"Mini" Launcher Bar
Left to Right:
• Site view
• Library
• HTML Styles
• CSS Styles
• Behaviors
• History
• HTML Edit View

Display
estimates
download
time of
your page

Display
shows
the size
of your
window
in pixels

Menu Bar
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In addition, Dreamweaver provides "Context Menus." These pop up when you right-click
on an object in your web page, such as a table or a graphic, to give you quick access to
commands specifically applicable to that object.

 The image below shows the Document Window surrounded by palettes and with a
context menu for a graphic in view.

This image from the Dreamweaver help files

Opening and closing Palettes:
If a desired  palette is not in view,
1. Click on the Window menu.
2. Choose the desired palette from the

drop menu
3. Close by clicking the "X" in a

palette's upper right corner.

What the Palettes do.

Palettes provide convenient access to
commands used for higher-end coding
and multi-page web sites. As you
become more skilled you will likely use
more and more of  them. The following
is a brief overview of their purposes,
focusing on those most commonly
necessary to the new web author.
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The Objects Palette
This palette largely echoes choices also found on the Insert Menu.
Pictured right is the "Common" objects palette. The Common
Objects palette, like its name implies, includes the most commonly
needed functions for newer users, including:

• Images
• Rollover images & Navigation Bars
• Tables
• Horizontal rules
• Mailto links (note: there is no icon here for a normal hyperlink)

See also p.14 for alternative mailto: method
• Flash, Shockwave, java applets, etc.

Note: You can set Dreamweaver preferences to add text labels to the
icons in the Objects Palette. From the Edit Menu, select Preferences.
From the General category/Object Palette drop menu, choose Icons
and Text.

At the top of the Objects palette is a down arrow. Clicking it reveals
a menu of the other views for this palette. Choices include:

Characters: A group of special text characters like copyright and
trademark.
Forms: The elements that make up an interactive form such as
check boxes.
Frames: Choices of frame layout styles for a web page.
Head: Insert elements into the HTML code between the
<head></head> tags. Includes keywords, descriptions, meta tags,
etc.
Invisibles: Insert anchors, comments, and more.
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The Properties Palette
The Properties Palette may be the most frequently used of these tools. With this you can
create and modify such things as

The Properties palette is context sensitive. The options will change depending on the
object selected to modify.

In the view below, this palette is set to modify text (this is also the default view)

In this next view, the palette is is set to modify an image.

Finally, we see the palette set to modify the look/structure of a table.

The Launcher Palette is also loaded from Dreamweaver's Window menu. This palette is
a floating version of the tool located at the bottom right of the Dreamweaver work screen.
As the Dreamweaver Window menu also offers menu picks for each of the tools on this
palette, there's not a whole lot of value to cluttering up your screen with this one.

Launcher Palette

"Mini Launcher"
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Section III: Creating Basic Web Page Elements

Dreamweaver's basic authoring functions are quite straightforward though manipulating
the properties of basic elements, such as tables and images, may be a little less obvious.

In this section, to cover the basic functions, we will create a simple personal home page
with the following elements:
• Text
• Table
• Image
• Hyperlink
• Mailto: link
• Background color

Note: SAVE YOUR PAGE NOW.  Saving a page before inserting elements helps avoid
prompts for defining full web sites and will help keep the code references calling for
links and images relative to the document.

Working with Tables

Tables can be used in web pages to layout and hold in place other elements such as text
and images. Note: While the trend has been toward using tables only for actual "tablular
data" due to accessibility concerns, using tables for layout will not make your page
inaccessable to people with disabilities. For more information on accessibility issues,
including working with tables, go to http://servercc.oakton.edu/~dannf/webaccess.htm.

To insert a table:
1. Click on the Insert Menu
2. From the menu, select Table

3. The Insert Table dialogue window will
appear. Here you can select the initial settings
for your table (Dreamweaver makes it easy to
alter the settings later on)

4. In the dialog window, set the
number of rows or columns by
dragging the curser across the
number and typing a new
number.
• Choose 1 Row and 2

Columns

(steps continued next page)
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5. The other settings may be adjusted as desired:
• Table width can be changed after inserting by dragging the table's edge border.
• A border setting of 0 means browsers will display no cell border lines
• Cell Padding and Spacing both essentially increase the spacing between cell

contents, 0 being tightest, 7 or 8 being pretty loose.
6. Click OK. Your table should appear in the document window.

Adjusting Table Dimensions
When your table first appears in the document window, it will have "handles" (small
tabs) on the bottom and
right edges which show
that the table has been
selected and can be
modified.
• You may adjust the

height and width of
the table by dragging the handles with the mouse.

• Table height and column width (not the overall table width) usually will increase
automatically to hold whatever you place in a cell.

• The handles will disappear (and the table will be unselected) when you click inside a
cell or outside the whole table

Modifying Table Properties
Some table properties are adjusted using the Properties Palette; others are adjusted using
the Modify/Table menu.  Many can be done either way. Methods for modification offered
below are "author's (that's me) choice" but should allow the new Dreamweaver user the
most control with the fewest headaches.

• To use most of the choices on the Modify/Table menu, first click anywhere inside the
table (otherwise most of the choices will be grayed-out)

• To use the Properties Palette you must
first select the table

To select a table:
1. Click anywhere inside the table
2. Click on the Modify Menu
3. Click on Table
4. Click on Select Table

• With the table selected, the
Properties Palette will change to
the Table Properties view
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Adding Rows and Columns

The Modify/Table Menu includes a selection called Insert Rows or Columns. Unlike
"Insert Row" and "Insert Column," this choice gives you more control over where the
column or row is placed
and allows for inserting
multiple rows and columns
in one step.

To use this command:
1. Click anywhere inside

a table.
2. Click on

the Modify Menu
then Table
then Insert Rows or
Columns
• A dialogue window will appear

3. Choose either Rows or Columns
4. Choose the number of Rows or Columns to insert

• You can type a number in the
field or use the up/down arrows
to change the number

5. Choose whether you wish the new
row(s) or column(s) should be
inserted

• For this exercise, click in the left-
most cell and choose to insert 1
column, before the selection.

6. Click OK

The Dialog window should close and the table should appear modified as below:
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Modifying Table Layout
With the table selected (the "handles" should be showing), the Properties Palette will
change to the table properties view.

In this view, you can change the following common layout features (others will be
covered in later lessons):

• Height & width. Set the height and width of the
whole table in terms of pixels or percent (the
percent of the browser window).

• Table alignment. Use the drop menu in the upper
right to set whether the table will be centered or
moved to the right or left side of the page

• Border width. Type a number from 0 (no border)
to 5 or 6 (for a thicker border)

• Background image. Type the name of the file (if
it's local) or click on the yellow file icon to locate
and chose the filename.

• Background color. Type a hex code in the field or
click the lower right of the box as shown to pick
from a color palette. This command will affect all
the cells of the table if the whole table is selected.
Otherwise it applies color to individual cells.

• Border Color. Type a hex code in the field or click
the lower right of the box as shown to pick from a
color palette. This command will affect all the
cells of the table if the whole table is selected.
Otherwise it applies color to individual cells.
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Working with Text
Text - Inserting
As with most web authoring programs, the essential method of inserting text with
Dreamweaver is this

To insert text:
1. Click somewhere on the page.
2. Type.
3. When finished, stop typing.

You can also copy and paste from most any other text-based document but the result is a
pretty boring chunk-o-text. Text must be formatted to achieve a more interesting look and
easy-to-read layout.

For purposes of this exercise, we'll stick to the "home page" concept and use the table we
created to contain the 'header' information. Type the following text (substitute your
personal information if desired) in the center cell of the 1-row by 3-column table:

Note on Line Breaks: Pressing Enter will give you a double-space between lines.
Shift-enter will single-space.

John Smith, PhD.
Professor of Webology
Room 1234
Phone x5678
Email: jsmith@oakton.edu

Your page should now look something like this (don't worry if the cell widths don't
match... yet).

As it is with word processing, what you type will appear to be in Dreamweaver's default
font-- generally Times Roman or Arial. This does not impact how the text will ultimately
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look in a web browser. If text is left unformatted, a web browser will apply its own
default.  (Even after formatting, it is still possible for a browser to override.)

Text - Formatting

Text formatting (e.g., size, typeface, color, etc.) can be accomplished in a number of
ways. More sophisticated web sites will use Style Sheets for much of this. Style Sheets
are a set of commands that control the look and layout of web pages. Depending on how
they are used, they can be applied to multiple pages or a portion of a single page.  Though
Style Sheets are beyond the scope of this introductory document, they are becoming
widely used and are worth learning as your skills and interest progress.

The most common way to format text in simple web pages is to apply formatting
commands to individual words, phrases or lines of text. This done by selecting the text
and using the Properties palette to make changes.

 To format text:
1. Drag the mouse across the desired text to

select it.
2. Use the Properties Palette  to change the

text appearance. If you are formatting text
in a table cell, the Properties palette will
show text commands on the upper half of the palette and table/cell commands in the
lower half.

Key to formatting commands on the Properties palette:

• Paragraph/Heading. If you are fomatting a line of text
that is essentially a headline introducing a section of the
document, choose one of the Heading sizes from the drop
menu. The appearance will be similar to choosing a text
size, but headings provide structural markup to the
document-- which browsers for disabled users depend on.

• Font style. "Default" applies no style and leaves the
appearance up to the browser when the page is displayed.
Because the success of declaring a font style requires that
other people's computers have that font installed, the five
main choices on this list are pretty safe for most
browsers. Each of the five selections has a 2nd and 3rd
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choice that will be applied if the preferred font is
unavailable.

• Text color. Type a 6-digit hex code into the text field or
click on the small down arrow near the upper left to
reveal a color palatte. The mouse pointer becomes an
"eyedropper" that can choose a color from the color
palette or can be pointed at an element on the web page
to duplicate its color.

• Bold and Italics. Functions like most word processors.
Choose one or both to apply that style to selected text.

• Alignment. Selected text can be left-justified, centered or
right-justified.

• Bullets and numbers. Select multiple lines of text then
click one of these to make the list bulleted or numbered.
To add to the list later, place the cursor at the end of a
line and press the Enter key. Note that if you wish to
format numbers and bullets, you may do so by going to
the Text Menu and clicking on "List."

• Indent/Outdent. Selected text will be moved left or right.

• Text size. Drop menu of relative text sizes.

Continuing our little exercise...

Suggested formatting for the Home Page header text.

1. Select "John Smith, PhD." by dragging the
mouse across the text.

2. Click on the Size drop menu on the
Properties palette and choose "+2"

3. Click on the Color palette and use the
eyedropper to choose a color

4. Click on the Bold button on the Properties
palette

The selected text should now be a little larger,
bolder, and have a different color than the rest of the
text in the cell.
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Working with Links

Creating Hyperlinks
There are two important types of links for a simple web page:
• A link to another page.
• A "mailto" link. Mailto links will pop up ane email composition window pre-

addressed to whoever the author desires (though usually himself)
These are created in similar ways, though the differences are important.

To create a link to another page:
• For this exercise, first type "Link to Yahoo" and

"Syllabus" below the table. We will assume that
John Smith has a second web page located in the
same folder as his home page called

"syllabus.htm."
1. Select the text "Link to Yahoo"
2. In the Properties palette, type

"http://www.yahoo.com" in the Link field.
3. Select the text "Syllabus"
4. In the Properties palette, type "syllabus.htm"

in the Link field

Above we see examples of two types of page links: Absolute and Relative. An absolute
link is one that contains the entire URL of a page; a relative link is one that contains just
enough information to locate the page relative to the current page. Generally speaking,
when linking between two web pages stored in the same folder, authors may use a
relative link which contains only the name of the web page file, such as "syllabus.htm."
For more information, see the document "Understanding Relative and Absolute URLs."
(See the list of online resources at the end of this tutorial.)

Creating a Mailto Link
To create a mailto link:
1. Select the text containing the email

address by dragging the mouse across it.
2. In the Properties palette's Link field, type

"mailto:jsmith@oakton.edu" (no spaces).

• A common mistake when creating a
mailto link is to type only the email
address with out "mailto:." The result is
that wen such a link is clicked on, the
browser will treat it like a page link and
try to locate a non-existant subfolder.
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Working with Graphics
Inserting Images
With Dreamweaver, it is important to save your web page before inserting graphics or
other files. Dreamweaver 'likes' to know where the graphics are in relation to the web
page (see note on page 7).  Graphics can be in the same folder as the web page or reside
on a different server-- the only real difference is how the link will be structured to show
its location in relation to the page.

For this exercise we'll insert two graphic images in the table on either side of the text and
assume the graphics are in the same folder as the web page.

To insert an image:
1. Click in the right cell of the table
2. Click on the Insert Menu and choose Image
3. The Select Image Source dialogue window will appear
4. In the dialog window, navigate to the folder containing the desired images (this

window works like any other 'File Open' dialogue).
5. Click on the filename to select/highlight it.
6. Click the Select button.

Note in the above window the File name field and the URL field contain identical
information. If the URL field contains a string like file:///H|/smithpic.gif, the picture
would not be accessible to people who can't access the author's "H" drive. Actually it's
more complicated than that. If you're new at this, just make sure the web page file and
the image file are in the same folder and you'll be fine.

If you were successful,
your page should look
something like this:

Repeat the previous six
steps to insert additional
images.
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Images - Alignment and other adjustments

With an image selected ("handles" showing), the Properties palette changes
to image mode and adjustments can be made to such things as alignment
(relative to other elements), size, etc. Images that reside in a table cell may
also be aligned using commands applied to the cell.

Below are some of the more common actions.

For vertical or horizontal alignment within a cell, click inside the
cell without selecting the picture and choose from the H/V drop
menus on the table Properties palette.

Horizontal alignment commands can be applied to the image (in a cell or
elsewhere on the page), by selecting the picture and clicking an alignment
choice from the Image Properties palette.

Image size. While best resolution and preservation of the aspect ratio is
achieved by actually editing a picture to the desired size in a program like
Photoshop or Fireworks, the display dimensions can be adjusted by
selecting the image and dragging one of the handles. The new dimensions will show on
the Image properties palette. You may also type the width and height in these fields rather
than drag the handles.

Alt text tags should be applied to all images on a web page. The alternative text will
show in a browser if the images are turned off. To add alt tags,
select the picture and type a short descriptive title for it in the Alt
text field.

Section IV: Key Dreamweaver Newbie Tips and Tricks

Editing HTML code
At some point most fearless web authors need to delve into the actual HTML code, either
to see what's going on or to make a correction. Dreamweaver makes it quick and easy to
switch between WYSIWYG view and HTML code view.

View and edit the HTML code by any of these methods:
• Press F10
• From either the Launcher bar or Mini-launcher bar, click the

HTML Source icon
• Click on the Window menu and choose HTML Source

Tip: If you are interested in the code behind a particular page element (image, text, etc.),
click on it in Document window/WYSIWYG view before switching to the HTML view.

To close the HTML edit window, click on the X in the upper right corner
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Page Properties
Easily overlooked, Page Properties is the place for setting several key features for any
web page, including title,
color schemes, and
backgrounds.

To launch page
properties:
1. Click on the Modify

Menu
2. Choose Page

Properties

Title
The most important setting
is the Title. Title is the
text that appears in the
blue bar running across the
top of a browser when
your page is in. It is also
the text under which a page is bookmarked and which provides the most important
information for cataloging your page to search engines.  Your "Title" should be a VERY
brief description of your page, such as "OCC - Professor Smith Home" or "OCC -
Webology Department"

Page Colors - Backgrounds, text and links
By default, Dreamweaver sets
• the background of a web page to solid white (hex code "#FFFFFF").
• Text and links to browser defaults
The color scheme of backgrounds, text and links can be reset by clicking on the to
launch the color palette. Note that the default colors are generally best for usability and
accessibility concerns.

Background Image
Choosing an image to tile across a page background will override the background color
choice. Set the image by clicking on browse and choosing it from the Select Image
Source dialogue window. It is usually best to have the desired image saved to the same
folder as the web page ("*.html") file.

Clean up Word HTML
Dreamweaver includes a feature for correcting poor HTML code resultant of creating
pages with Microsoft Word (Word's 'Save as HTML/Web' feature).
Click on the Commands Menu and choose Clean Up Word HTML.

Previewing a page in a browser window
Press the "F12" key to view your page in an actual web browser window.
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Online Resources

Faculty Web Page How-to Guide: http://www.oakton.edu/resource/it/templateintro.htm
Web Page Templates: http://www.oakton.edu/resource/it/templates.htm
Word and Web Pages: http://www.oakton.edu/resource/it/word97andwebpages.pdf
Web Accessibility: http://servercc.oakton.edu/~dannf/webaccess.htm
Relative & Absolute URLs: http://www.oakton.edu/resource/it/relativeurls.doc
Dreamweaver Support Center: http://www.macromedia.com/support/dreamweaver/


